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Getting started
iPod for Windows works with MUSICMATCH Jukebox, included with 

your iPod. Use MUSICMATCH Jukebox to organize music from your CD

collection, then transfer songs to iPod for listening on the go. Read on 

to find out how to get started playing music with iPod.

Charge the battery.

Connect iPod to the iPod Power 

Adapter using the included FireWire 

cable. Plug the power adapter into a

working outlet for at least one hour to

charge the battery. iPod’s battery is 

80-percent charged in about an 

hour, and fully charged in 4 hours.
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If you don’t already have MUSICMATCH Jukebox 7 with 

the iPod plug-in software, install it using the “iPod for

Windows”CD.

Connect iPod.

Start up your computer and connect iPod using the included

FireWire cable. If your computer has a 4-pin FireWire (IEEE

1394) port, use the included 6-pin to 4-pin adapter.
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Transfer music.

When MUSICMATCH Jukebox opens, it automatically transfers

the songs in your music library to iPod.

Play music.

Use iPod’s scroll wheel and Select button to browse for a song.

Then press the Play button and enjoy!
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Using iPod
Once you transfer songs to iPod, it’s easy to browse for and 

listen to songs. Read on for tips on using iPod.You can also find

information about using iPod in iPod onscreen help and on 

the Web (see “Learning more, service, and support”).
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Turning iPod on and off

To turn iPod on, press any button. If a song is paused or no song is

playing, iPod turns off automatically after two minutes.To turn iPod 

off immediately, press and hold the Play button for a few seconds.

Disabling iPod’s buttons using the Hold switch

If you’re carrying iPod in your pocket and you don’t want to 

press the buttons accidentally, set the Hold switch to make the

buttons inactive.

Turning on the backlight

To turn iPod’s backlight on or off, press and hold the Menu button.
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Using iPod’s controls

Use iPod’s buttons and scroll wheel to navigate through iPod’s

onscreen menus.To select a menu item, use the scroll wheel

to scroll to the item, then press the Select button (in the

center of iPod).To go back to the previous menu, press the

Menu button.

Playing a song

You can browse for songs by artist, album, title, genre, or composer. If you

transfer playlists (songs you’ve organized into lists) from MUSICMATCH

Jukebox to iPod, you can also browse for songs in playlists.

Select Playlists or Browse in iPod’s main menu, then navigate to a song

and press the Select button to play the song.To play all the songs by an

artist, on an album, or in a playlist, press the Play button when the artist,

album, or playlist name is highlighted.

Changing the volume 

If you see the Now Playing screen, which shows the title of the song 

playing, you can use the scroll wheel to adjust the volume. If you don’t 

see the Now Playing screen, select Now Playing in the main menu.

You can also use the iPod Remote (available with some models)

to adjust the volume.
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Transferring music

By default, iPod is set to transfer music automatically when

you connect it to your computer.You can also transfer and

delete individual songs manually.

To change iPod’s settings, open MUSICMATCH Jukebox and select

“Download files to portable devices” from the File menu.Then select

iPod and click the Options button.

Using the Apple iPod Remote

To use the iPod Remote, connect it to iPod’s headphones

port, then connect the Apple Earphones (or another set 

of headphones) to the remote. Use the remote to adjust

volume, play or pause a song, fast-forward and rewind,

and skip to the next or previous song. Set the remote’s 

Hold switch to lock the remote’s buttons.

The iPod Remote is included with some models of iPod

and can be purchased separately at www.apple.com/store
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Importing addresses and phone numbers

Your iPod can store up to a thousand contacts for viewing on the go.

1 Connect iPod and open your favorite email or contacts application.

Importing contacts works with such programs as Palm Desktop,

Microsoft Outlook, and Eudora.

2 Export contacts as vCard files and copy them to the Contacts folder on 

iPod.You can do this by dragging contacts from the application’s

address book to iPod’s Contacts folder in Windows Explorer. iPod must

be enabled for use as a FireWire hard disk.

3 Eject and disconnect iPod. Select Extras in the main menu, then select

Contacts. For more information, see iPod Help, available in the

MUSICMATCH Jukebox Help menu.
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Changing settings

Select Settings in iPod’s main menu to change settings.You can set 

iPod to shuffle or repeat songs, change equalizer settings, set a 

backlight timer, and more (see “Learning more, service, and support”

for more information).

Charging the battery

To charge iPod’s battery, connect iPod to the iPod Power

Adapter (included) and plug the adapter into a working

outlet. iPod’s battery is 80-percent charged in about 

an hour, and fully charged in 4 hours. If the battery icon

on iPod’s screen is not animated, its battery is 

fully charged.

If your computer has a 6-pin FireWire port, you may be able to

charge iPod by connecting it to your computer. If iPod is charging,

the charging icon appears on its display.

Software Update

Apple periodically updates iPod software to improve performance

or add features.To download the iPod Software Updater application,

go to www.apple.com/ipod



Tips and troubleshooting
Read on for advice about using and troubleshooting iPod.

What are the iPod for Windows system requirements?

You can use iPod with a computer and software that meet the 

following requirements:

• PC with 300 MHz or higher processor speed

• 96 MB RAM (128 MB for Windows XP)

• Windows ME,Windows 2000,Windows XP or later

• Built-in or compatible FireWire card (IEEE 1394) installed

For more information on compatible FireWire cards,

go to www.apple.com/ipod 

For information on installing a FireWire card, see the instructions 

that came with the card or with your computer.

• MUSICMATCH Jukebox 7 or later with the iPod plug-in (included on 

the “iPod for Windows”CD) 
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• Make sure iPod’s Hold switch is off.

• If you’re using the Apple iPod Remote, make sure the remote’s

Hold switch is off.

• If that doesn’t work, connect iPod to the iPod Power Adapter 

and connect the adapter to a working outlet.Your iPod battery

may need to be recharged.

• If that doesn’t work, your iPod may need to be reset.While the

iPod is connected to power, press and hold the Play and Menu

buttons for at least 5 seconds, until the Apple logo appears.

• If that doesn’t work, you may need to restore iPod’s software.

To download the iPod Software Updater application, go to

www.apple.com/ipod

My iPod isn’t playing music.

• Make sure iPod’s Hold switch is off.

• If you’re using the Apple iPod Remote, make sure the remote’s

Hold switch is off.

• Make sure the earphone connector is pushed in all the way.

• Make sure the volume is turned up.

• If that doesn’t work, push the Play/Pause button.Your iPod 

may be paused.
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When I connect my iPod to my computer, nothing happens.

• Make sure you have the required computer and software.

See “What are the iPod for Windows system requirements?”above.

• Open MUSICMATCH Jukebox and choose “Download files to

portable devices” from the File menu.You should see the iPod icon

in the devices window.

• If that doesn’t work, check the FireWire connections. Unplug the

FireWire cable at both ends and make sure no foreign objects are 

in the FireWire ports.Then plug the cable back in securely. Use

only the Apple 6-pin to 6-pin FireWire cable and 6-pin to 4-pin

adapter (if necessary).

• If that doesn’t work, your iPod may need to be reset. Connect iPod 

to the iPod Power Adapter and connect the adapter to a working

electrical outlet.Then press and hold the Play and Menu buttons

for at least 5 seconds, until the Apple logo appears.

• If that doesn’t work, restart your computer.

• If that doesn’t work, you may need to restore the iPod software.

To download the iPod Software Updater application, go to

www.apple.com/ipod

For more information, go to the iPod support site at

www.apple.com/support/ipod
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• The FireWire port cover (available with some models of iPod) is

designed to be removable. If it comes off, you can reinsert it.

My Apple iPod Remote isn’t working.

• Make sure the remote’s Hold switch is off.

• Make sure the remote is plugged firmly into iPod’s headphones

port, and that the Apple Earphones are plugged firmly into 

the remote.

• The iPod Remote is included with some models of iPod, and can

be purchased separately at www.apple.com/store
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iPod onscreen help

To access iPod Help, open MUSICMATCH Jukebox and choose MUSICMATCH Jukebox
Help from the Help menu.Then click “Apple iPod Help.”
In iPod Help, you can find information on
• transferring music and data files to iPod 
• automatically updating iPod 
• using playlists
• changing settings
• file types supported by iPod, and more

Online resources 

For the latest information on iPod, go to www.apple.com/ipod

For iPod service and support information, a variety of forums with product-
specific information and feedback, and the latest Apple software downloads,
go to www.apple.com/support/ipod

For MUSICMATCH Jukebox service and support information, go to
www.musicmatch.com
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Learning more, service, and support
There is a wealth of information about using iPod in onscreen help 

and on the Web.
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www.microsoft.com

For international support, go to www.apple.com/support and choose your
country from the pop-up menu at the bottom of the screen.

Obtaining warranty service

If the product appears to be damaged or does not function properly, please 
follow the advice in this booklet, the onscreen help, and the online resources.
If the unit still does not function, go to www.apple.com/support for instructions
on how to obtain warranty service.

Communications regulation information

For information on communications regulations, see the file on the “iPod for
Windows”CD.
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Safety and cleaning
Read on to learn about using iPod safely and cleaning iPod.

Important safety instructions

When setting up and using your iPod, remember the following:
• Read all the installation instructions carefully before you plug your 

iPod Power Adapter into a power outlet.
• Keep these instructions handy for reference by you and others.
• Follow all instructions and warnings dealing with your iPod.
Warning Electrical equipment may be hazardous if misused. Operation of this
product, or similar products, must always be supervised by an adult. Do not
allow children access to the interior of any electrical product and do not permit
them to handle any cables.

Avoid hearing damage

Warning Permanent hearing loss may occur if earphones or headphones are
used at high volume.You can adapt over time to a higher volume of sound,
which may sound normal but can be damaging to your hearing. Set your iPod’s
volume to a safe level before that happens. If you experience ringing in your
ears, reduce the volume or discontinue use of your iPod.
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Do not use while driving

Important Use of headphones while operating a vehicle is not recommended
and is illegal in some areas. Be careful and attentive while driving. Stop listening
to your iPod if you find it disruptive or distracting while operating any type of
vehicle or performing any other activity that requires your full attention.

Using the power adapter

• Use only the power adapter that came with your iPod. Adapters for other
electronic devices may look similar, but they may damage your iPod.

• The only way to shut off power completely to your power adapter is to
disconnect it from the power source.

• Always leave space around your power adapter. Do not use this equipment 
in a location where airflow around the power adapter is confined, such as 
a bookcase.

• When connecting or disconnecting your power adapter, always hold the
power adapter by its sides. Keep fingers away from the metal part of the plug.

• Before connecting the FireWire cable to the power adapter, make sure there
are no foreign objects inside the adapter’s FireWire port.

• The power adapter for your iPod is a high-voltage component and should not
be opened for any reason, even when the iPod is off. If the power adapter
needs service, see “Learning more, service, and support.”

• Never force a connector into the power adapter FireWire port. If the connector
and port do not join with reasonable ease, they probably don’t match. Make
sure that the connector matches the port and that you have positioned the
connector correctly in relation to the port.
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About operating and storage temperatures

• Operate your iPod in a place where the temperature is always between
0 and 35º C (32 to 95º F).

• Store your iPod in a place where the temperature is always between 
–20 and 45º C (-4 to 113º F).

• iPod’s battery life may shorten in low-temperature conditions.
• When you are using your iPod or charging the battery, it is normal for the

bottom of the case to get warm.The bottom of the iPod case functions 
as a cooling surface that transfers heat from inside the unit to the cooler 
air outside.

Avoid wet locations

Warning To reduce the chance of shock or injury, do not use your iPod in or near
water or wet locations.
• Keep your iPod and power adapter away from sources of liquids, such as

drinks, wash basins, bathtubs, shower stalls, and so on.
• Protect your iPod and the power adapter from direct sunlight and rain or 

other moisture.
• Take care not to spill any food or liquid on iPod or its power adapter. If you do,

unplug iPod before cleaning up the spill.
Depending on what you spilled and how much of it got into your equipment,
you may have to send your equipment to Apple for service. See “Learning more,
service, and support.”
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Do not make repairs yourself

Warning Do not attempt to open your iPod or power adapter, disassemble it,
or remove the battery.You run the risk of electric shock and voiding the limited
warranty. No user-serviceable parts are inside.
For service, see “Learning more, service, and support.”

Cleaning

Follow these general rules when cleaning the outside of your iPod and 
its components:
• Make sure your iPod is unplugged.
• Use a damp, soft, lint-free cloth. Avoid getting moisture in openings.
• Don’t use aerosol sprays, solvents, alcohol, or abrasives.

About handling

Your iPod may be damaged by improper storage or handling. Be careful not 
to drop your iPod when playing or transporting the device.
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請勿自行維修

【警告】請勿嘗試打開 iPod 或電源轉換器、解體或拆卸電池。這樣可能

會導致電擊和使產品的保固失效。iPod 本身沒有使用者可以自行維修的

部份。

關於維修服務的相關資訊，請參閱“其他相關內容、服務和技術支援資

訊”部份。

清潔

請依照以下的一般規則來清理 iPod 的外部及其組件：

• 請先確定 iPod 已經關機並拔掉電源。

• 使用微濕、柔軟且沒有線頭的布料輕輕擦拭。並避免讓機身的開口處

受潮。

• 請勿使用噴霧劑、溶劑、酒精或研磨劑。

關於處理使用

不適當的儲存或處理可能會對 iPod 造成損害。請小心播放或運送本設

備，不要使其摔落地面。
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